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General 

Who can I contact regarding StarMOBILE help, questions, and concerns? 

Before contacting someone regarding StarMOBILE questions and concerns, review the 
following:  

• Review this StarMOBILE FAQ (Frequently Asked Questions) document 
• Visit one of the following websites for information pertaining to your question 

Web Site Link 
DCCTools Website www.dcctools.com 
StarMOBILE Information DealerCONNECT > Service > Repair > StarSCAN/StarMOBILE 
DealerCONNECT eSupport Link DealerCONNECT > Service > Repair > Star Online 
STAR Center Online DealerCONNECT > eSupport > Knowledge Center > Find Answers 

If your problem cannot be resolved through the steps above, please call the Technical Service 
Hotline associated with the problem you are experiencing. They will help you resolve the issue 
or direct you to the appropriate resource. 

Type of Problem Location Hotline Number
US STAR Center  +1 800-850-7827

Canada (French) STAR Center  +1 800-361-1702
Canada (English) STAR Center  +1 800-361-2702

Mexico STAR Center  +52 55 5081 7279, +52 55 5081 7063
 

Europe (Brussels) STAR Center  +32 27 75 4532

US DealerCONNECT  +1 800-374-4040

Canada Auto Analyser  +1 866-233-6733

Mexico DealerCONNECT  +52 55 5081 7389, +52 55 5081 7390

Europe, Middle East, South 
America (Brussels) DealerCONNECT  +32 2 706 2551

Australia DealerCONNECT  +61 03 9566 9276

All other countries DealerCONNECT  +1 780 409-4588

US Bright Star Engineering  +1 617-224-4990
 

Canada Bright Star Engineering  +1 617-224-4990

International SPX  +44 0 1327 303467

StarMOBILE Diagnostic 
Tool Repair

Vehicle Diagnosis Issues

Software Installation Issues 
and Networking Issues

 

Where do US customers send their StarMOBILE tools in for repair?  

Before StarSCAN or StarMOBILE units are sent in for repair, it is recommended that a call 
first be placed with the North American Help Desk at (800) 374-4040.  Basic troubleshooting 
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of the problem via the help desk may save you from unnecessarily sending in the unit for repair 
and avoid shipping and service fees. 
 
Once the North American Help Desk has determined that the problem is with the tool itself, the 
tool can be sent in for repair by calling Bright Star Engineering at 617-224-4990. 

Where's the carrying case? 

The carrying case was dropped from the kit by a marketing decision since they are rarely used.  
A carrying case (CH9805) is, however, available for separate purchase. 

What is the process for ordering a StarMOBILE carrying case? 

To order a StarMOBILE carrying case, complete the following steps: 
 

1. Call Miller Special Tool at (800) 801-5420 
2. Request StarMOBILE Carrying Case (P/N CH9805) 

What are the minimum PC requirements for running StarMOBILE? 

The StarMOBILE Desktop Application software that runs on the PC uses the same PC 
requirements as DealerCONNECT. 

Tool Features 

Why do I need a StarMOBILE?  How is it different from a Co-Pilot tool? 

The StarMOBILE diagnostic system is the newest Chrysler Group diagnostic tool.  It extends the 
functionality of the StarSCAN® diagnostic tool by providing the following additional capabilities: 
Customer Data Recorder: The StarMOBILE system supplements the Co-Pilot as a customer 
flight recorder for Controller Area Network (CAN) vehicles. It has expanded event storage 
capability and is able to simultaneously record data elements across multiple ECUs, including 
body modules. During data recording, the StarMOBILE system will record readings selected by 
the technician when the tool is triggered in the vehicle by the customer. 
Pass-Through Diagnostics: In this operation the StarMOBILE system operates in conjunction 
with a PC to allow scan tool functionality including: data displays, actuators, diagnostic routines, 
and vehicle flash functions. Unlike the Co-Pilot, which was designed strictly for use in the 
customer’s vehicle, the StarMOBILE system can be put to work throughout the Service 
Department. 

What are the different operating modes of the StarMOBILE device? 

The StarMOBILE device can operate in three different modes: Flight Recorder mode, Pass-
Through mode, or Standalone mode: 
 
Pass-Through Mode:  This mode is selected when you want to use the device in conjunction 
with a PC as a full-featured diagnostic tool. 
Flight Recorder Mode (A.K.A. - Data Recorder Mode):  Use this mode when you want to use the 
device as a customer flight recorder. 
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Standalone Diagnostic Mode:  This mode provides basic diagnostic functions such as flashing 
ECUs, setting customer preferences, or reading DTCs without the use of a PC.   
 
Note:  When not in Pass-Through mode, the networking capabilities of the device are disabled. 

What is the StarMOBILE Standalone Diagnostic Mode and how do I enter it? 

The StarMOBILE Standalone mode allows you to perform the following basic diagnostic tasks 
without being connected to a PC.  
 

• Reading and Clearing DTC's 
• Clearing All DTC's 
• Changing Customer Preferences 
• Flashing ECU's 

 
To enter Standalone mode, select Enter Standalone Diagnostic Mode from the main menu of 
the StarMOBILE device: 
 

 
 
Refer to the StarMOBILE Standalone Diagnostic Mode User Guide located in the Download 
Center at www.dcctools.com or on DealerCONNECT under Service > Repair > StarSCAN and 
StarMOBILE Tools > Download Center for more information. 

Why isn’t the Standalone Diagnostic Mode software updating properly? 

If you have installed the update on the StarMOBILE device via the USB device, the new 
Standalone Diagnostic Mode will not be available until the Desktop Client has been updated, 
detects the StarMOBILE device on the network and asks you to install the Standalone 
Diagnostic software. 

To resolve this issue complete the following steps: 

1. Update the StarMOBILE desktop Client via the latest StarSCAN StarMOBILE Update 
CD. 

2. Place your StarMOBILE device on the network via a wired Ethernet or wireless 
connection. 

3. After the StarMOBILE Desktop Client discovery process connects you to a StarMOBILE 
device, you will be prompted to install the new Standalone Diagnostic Mode feature on 
the StarMOBILE device. 

http://www.dcctools.com/
https://dealerconnect.chrysler.com/portal/Controller/service
https://dealerconnect.chrysler.com/portal/Controller/service?qwerty=25342276467984-t7990ab-99970
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4. Follow the instructions.  If the Standalone Diagnostic Mode has been successfully 
installed on your StarMOBILE device, you will see the Enter Standalone Diagnostic 
Mode menu item on the Main Menu. 

 

 

What are the different operating modes of the StarMOBILE Desktop Client application? 

The StarMOBILE Desktop Client application can operate in Connected or Disconnected mode.  
When in Connected mode, the Desktop Client is connected to a StarMOBILE device.   
 
When in Disconnected mode, the Desktop Client is not connected to a StarMOBILE device.  
The feature set is limited when in Disconnected mode, but this mode can be useful for creating 
templates or viewing recordings while not connected to a StarMOBILE device.  Disconnected 
mode can also be used to download flash files or check to see if flash files apply to a particular 
vehicle’s ECU without being connected to an actual vehicle. 

How do I change operating modes on the StarMOBILE device? 

To change operating modes, select the operating mode you desire from the main menu of the 
StarMOBILE device.  Operating modes include Pass-Through, Flight Recorder, and Standalone.  
Note: When the Main menu is displayed, you are in Pass-Through mode. 
 

 
 

Are the vehicle cables for StarMOBILE and StarSCAN interchangeable? 

No.  Both cables use the same connectors, but are not interchangeable.  Each tool has a unique 
cable that is distinguished by the color of the HD-26 connector and by the part number located 
on the tool end of the cable: 

• StarMOBILE Cable: CH9804, blue HD-26 connector 
• StarSCAN Cable: CH9404, black HD-26 connector 
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Where are files saved when I perform operations using the Desktop Client? 

All files that are created while using the Desktop Client are saved to the PC.  Data recordings 
are created and stored on the StarMOBILE device itself until you select View Recordings, at 
which time they will be moved to the PC. 

What are the different power modes for my StarMOBILE and why does it turn off? 

The StarMOBILE has two distinct operating modes: Pass-Through Mode' and Flight Recorder 
Mode.  The power scheme of the device will change based on which mode is selected.  The 
information below describes the different power scheme behaviors. 
 
Flight Recorder Mode Power Scheme information: 
 
General Information: 

• When booted up in this mode there is a 2 minute period where the device will stay on 
regardless of CAN (Controller Area Network) bias or vehicle power states. 

 
Wake-Up Conditions: 

• Wake-Up occurs if the system senses a transition from no CAN bias to CAN bias 
present. 

• Wake-Up occurs when you press the power button. [assuming the battery is somewhat 
charged or an external power source is present] 

• Wake-Up occurs if you press the trigger button. [assuming the battery is somewhat 
charged or an external power source is present] 

 
Shutdown Conditions: 

• Shutdown (graceful) occurs if you press the power button twice. 
• Shutdown (graceful) occurs if the system detects that there is no vehicle power. (only 

after the system has been running at least 2 minutes) 
• Shutdown (graceful) occurs if the system detects a loss of CAN bias (only after the 

system has been running at least 2 minutes). 
• Shutdown (graceful) occurs if the system detects that no vehicle responses have been 

received in 5 minutes (at least one good response must have been received to start 
countdown). 

• Shutdown (forced) occurs if you press and hold the power button for 5 seconds. 
 
Pass-Through Mode Power Scheme information: 
 
Wake-Up Conditions: 

• Wake-Up occurs when you press the power button. [assuming the battery is somewhat 
charged or an external power source is present] 

 
Shutdown Conditions: 

• Shutdown (graceful) occurs if you press the power button twice. 
• Shutdown (graceful) occurs when the system voltage of the device falls below a level at 

which it can safely operate. 
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• Shutdown (forced) occurs if you press and hold the power button for 5 seconds. 
 
General Power Information (not specific to a particular mode): 

• If, while powering up, the unit discovers that the internal battery has insufficient charge 
to continue operation, the system will immediately shut down again.  This is an indication 
that the battery should be charged. 

• If the internal battery is completely drained, the unit will power up with no user action as 
soon as an external power source (wall transformer or vehicle) is available.  If the unit 
powers up "all by itself" when first plugged in, this is an indication that the battery should 
be charged. 

 

Why does my StarMOBILE keep turning off and then back on again? 

The StarMOBILE uses an internal battery to operate when it is not connected to an external 
power source.  The information in this article is specifically related to a condition that occurs 
when the device is being powered solely from the internal battery.  There are certain conditions 
where the internal battery will be unable to provide sufficient power to the StarMOBILE.  When 
the battery is unable to provide sufficient power the StarMOBILE device may automatically turn 
off, then automatically turn back on repeatedly. 
 
Reasons why the battery can not provide sufficient power to the StarMOBILE: 
 

• The StarMOBILE internal device battery has an insufficient charge.  Even though the 
device will automatically shut itself down once the internal battery has dropped below a 
sufficient charge, it can continue to decline over time 

• At high temperatures (refer to the StarMOBILE Read-Me First) the internal battery safety 
circuitry will suspend charging of the battery to prevent unsafe conditions. 

• At low temperatures, the efficiency of lithium ion batteries reduces significantly.  At these 
temperatures the battery output may not be sufficient to sustain the device. 

 
If you are experiencing this condition it can be remedied by attaching the StarMOBILE to an 
external power source such as the StarMOBILE A/C power adapter (P/N CH9802) or to a 
vehicle using the StarMOBILE J1962 Vehicle Cable (P/N CH9804).  Once the battery has a 
sufficient charge the above condition will not occur. 

Why does my StarMOBILE device stay charged for only a few days when powered off? 

The StarMOBILE customer data recorder feature requires a small portion of its circuitry to 
remain powered to monitor vehicle signals even when the StarMOBILE is powered off.  A fully 
charged StarMOBILE will function for up to two hours when powered up, and up to 5-7 days 
when powered down.  Your StarMOBILE device will charge its internal battery when connected 
to an external power source even when the device itself is powered down.  To maintain the 
charge on your StarMOBILE device when not in use, connect it to the StarMOBILE A/C power 
adapter (P/N CH9802). 
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Can I use my StarMOBILE if the battery is dead? 

Yes. A dead battery in the StarMOBILE does not affect its operation.  Connecting the tool to 
another power source, either through the AC adapter or a vehicle connection will allow normal 
operation.  The only effect of the dead battery is an inability of the tool to operate without an 
external power source. 

Does my StarMOBILE battery charge when it is connected to a vehicle? 

Yes, assuming adequate vehicle battery voltage is available. 

Can I use my StarMOBILE battery charger on the StarSCAN?  

The StarMOBILE charger should not be used with the StarSCAN tool.  You can, however, use 
the StarSCAN battery charger on your StarMOBILE device.  

How many recordings can my StarMOBILE tool hold? 

The following must be considered: 
• The number of recordings that can be made on StarMOBILE is dependant on the size of 

the recordings. 
• The two factors that make up how big a recording will be are the number of data items 

recorded and the length (in time) of the recording.  With more data items selected, 
and/or a longer recording time, the total amount of possible recordings is decreased. 

• Regardless of recording size, the tool should be able to store approximately 20 
recordings.  

 
It is highly recommended that Technician and or Dealer Representative instruct the 
customer/vehicle owner to only take recordings when the intermittent condition is actually 
occurring.  This will decrease the amount of time it takes the technician to sift through invalid 
recordings. 

What is the Vehicle Preparation feature? 

Vehicle Preparation provides users with a list of common functions typically used during new 
vehicle preparation.  Examples include: 

• Sound Horn On Lock 
• Flash Hazard Lamps On Lock 
• Headlamps Delay Time 
• Illuminated Entry Time 
• Program Additional Ignition Keys 

 
All items that are available under Vehicle Preparation can also be found by navigating to ECU 
View > ECU Overview > Misc. Functions and ECU View > ECU Overview > More Options > 
System Tests.  

How do I print StarMOBILE Desktop Client screens? 

You can capture StarMOBILE Desktop Client screens using the Windows Print Screen function.  
To create a screenshot of just the client window follow the below steps: 
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1. Ensure that the Desktop Client window is selected.  You can do this by ‘left’ clicking on 

the screen with your mouse. 
2. Press and hold down one of the ‘Alt’ keys on your keyboard. 
3. Press the ‘Print Screen’ key while holding down the ‘Alt’ key.  This will place a copy of 

the screenshot on the clipboard, which allows it to be pasted into any program that will 
accept a picture, such as MS Paint.  Once there, it can be saved or printed.  

 

 
 

4. To view and print the captured screenshot, paste the captured screen into a program 
(such as MS Word) by hitting the Ctrl and C keys simultaneously while in the MS Word 
application.  

 

 
 

What are the meanings of the status icons on the StarMOBILE Desktop Client title bar? 

The StarMOBILE (SM) Connection Status Icons in the upper right hand corner can tell you all 
about SM connections to both the vehicle and the network. 
 

 
 

The icon furthest to the right displays StarMOBILE device and vehicle connection information.  
When the StarMOBILE Desktop Client is not connected to a StarMOBILE device, the SM icon is 
shown with a red slash.  Clicking on the icon in this state will launch the discovery wizard which 
allows the StarMOBILE Desktop Client pc application to connect to a SM device (if one is 
available on the network). 

 
Figure 2:  Not connected to a StarMOBILE device (Standalone mode) 

 
Once the SM Desktop Client is connected to a SM device, the far right icon shows the vehicle 
connection status.  The icon is a picture of the vehicle data link connector (J1962), with a red 
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slash when not connected (see Figure 3) and a clear picture when connected to a supported 
vehicle (see Figure 4). 
 

 
Figure 3:  Not connected to a vehicle 

 

 
Figure 4:  Connected to a vehicle 

 
The two center icons represent network connection of the StarMOBILE device.   They do not 
give an indication of the connection status of the computer that is running the SM Desktop 
Client software. 
 
The left (center) icon represents wireless connection.  The wireless connection icon is made of 
progressively larger bars, which are marked green as signal strength increases, much like the 
battery icon (see Figure 5).  This icon will display the strength of the wireless signal that the SM 
is receiving. 

 
Figure 5:  No wireless network connection 

The right (center) icon represents if a wired connection is active between the SM device and the 
dealership’s wired network.  This icon is a standard wired network graphic (see Figure 6). 

 
Figure 6:  Wired network connection 

 
Both icons use a gray slash when they are not connected and or active (see Figures 7 and 8). 

 
Figure 7:  No wired network connection 

 

 
Figure 8:  No wireless network connection 

 
If you are connected to a StarMOBILE, one of these network status icons must be active.  
Clicking on either network icon will allow you to only view the settings for the respective network 
connection.  You can not modify the settings from this view as this must be done by connecting 
to the SM directly via the ‘StarMOBILE Configuration Browser’.  For more information on how to 
connect to the ‘StarMOBILE Configuration Browser’ please refer to the answer to the question 
“How do I setup my StarMOBILE on the network?” located in the Networking section of this FAQ 
document. 
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Networking 

How do I setup my StarMOBILE on the network? 

Help is available at the DealerCONNECT and DCCTools websites.  
 
The StarMOBILE Initial Network Setup training aid is available in the Training Aids tab under 
Service > Repair > StarSCAN and StarMOBILE Tools on DealerCONNECT and under the 
Training Aids > StarMOBILE Training Aids section at www.dcctools.com.  This macromedia 
flash training aid will walk you through the initial network configuration of your StarMOBILE 
device. 

 

A PDF document (StarMOBILE Configuration Guide) is also available in the Online 
Documentation tab under Service > Repair > StarSCAN and StarMOBILE Tools on 
DealerCONNECT and at the Download Center at www.dcctools.com.  This document provides 
a full explanation regarding how to enable and connect your StarMOBILE device to your 
dealership’s network. 

Who should configure my StarMOBILE device for networking? 

We strongly recommend that your Network System Coordinator configure your StarMOBILE 
device for networking due to the inherent complexity of establishing a secure networking 
environment.  Note: DealerCONNECT Hotline personnel may require access to your Network 
System Coordinator in order to troubleshoot StarMOBILE networking problems. 

What should I do if I have problems configuring my StarMOBILE device for networking? 
What should I do if I have problems discovering StarMOBILE devices on my network? 

To troubleshoot StarMOBILE networking issues, refer to the StarMOBILE Network 
Troubleshooting Guide available at https://dealerconnect.chrysler.com by navigating to 
DealerCONNECT > Service > Repair > StarSCAN and StarMOBILE Tools.  The guide is also 
available from the Download Center at http://www.dcctools.com. 
 
You can also obtain help with your networking problems through the DealerCONNECT Hotline 
at 800-374-4040.  DealerCONNECT Hotline personnel may require access to your Network 
System Coordinator in order to troubleshoot StarMOBILE networking problems.   

https://dealerconnect.chrysler.com/portal/Controller/service
https://dealerconnect.chrysler.com/portal/Controller/service?qwerty=25342276467984-t7990ab-99970
http://www.dcctools.com/
https://dealerconnect.chrysler.com/portal/Controller/service
https://dealerconnect.chrysler.com/portal/Controller/service?qwerty=25342276467984-t7990ab-99970
http://www.dcctools.com/
https://dealerconnect.chrysler.com/
http://www.dcctools.com/
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Why does the discovery wizard show '???' characters in the discovery wizard table? 

When the StarMOBILE is used to connect to any 2006 Jeep Liberty (KJ) the discovery wizard 
always displays “???” in the place of the vehicle’s year, body and VIN. 
 

 
 
This is the normal behavior, and does not indicate a problem.  The reason the question marks 
are displayed is because the StarMOBILE is expecting there to be a Central Gateway ECU that 
it can retrieve the Year, Body and VIN information from.  The 2006 KJ does not have a Central 
Gateway ECU so the tool returns '???'. 
 
On a standard CAN vehicle the central gateway is also used by the StarMOBILE to begin the 
Flight Recording process.   Since the 2006 KJ has no Central Gateway ECU the StarMOBILE 
can not be used to do a flight recording on this vehicle. 
 
The StarMOBILE and StarSCAN are used on the 2006 KJ for the standard diagnostic 
functionality. The StarMOBILE can not be used for Flight Recording on the 2006 KJ.  The Co-
Pilot can be used to record data on the 2006 KJ. 

What happens when I run the Test connection feature of my network settings? 

An attempt is made to connect to DealerCONNECT from your PC.  This test does not reflect the 
connection that exists between your PC and the StarMOBILE device. 

Does the StarMOBILE device support Ad-Hoc wireless networking? 

Ad-hoc wireless networking has been tested but it is not officially supported due to problems 
with the Microsoft Windows implementation.  Because of the potential usefulness of Ad-Hoc 
networking, we have made Ad-Hoc networking available as an unsupported feature.  You are, 
however, left to your own resources to get Ad-Hoc networking working in your environment. 

What do the networking icons indicate on the StarMOBILE Desktop Client application? 

The wired and wireless icons in the system tray of your StarMOBILE Desktop Client application 
reflect the network status of the StarMOBILE device only; they do not reflect the network status 
of your PC. 

Why should an Access Point be used instead of a Wireless Router? 

A wireless access point is a networking device that allows wireless devices to connect to a 
wired network.  The wireless access point extends or bridges the existing wired network into the 
wireless space. Any device on the wireless network shares the same network access as a wired 
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device.  We recommend using a wireless access point to connect a StarMOBILE to an existing 
wired network. 
 
A wireless router is device that manages traffic flow between a wireless network and a wired 
network.  A wireless router creates a separate network for the wireless devices connected to it.  
In creating a separate network, devices on the wireless network have different IP settings than 
those connected to the wired network.  Devices on the wireless network can connect to devices 
on the wired network, but the opposite is not true.  Devices on the wired network have no way of 
contacting a wireless device under normal circumstances.  This causes problems with a 
StarMOBILE Desktop Client on the wired network that is attempting to contact a wireless 
StarMOBILE tool.  Wireless routers are not recommended or supported when implementing a 
StarMOBILE system. 
 
If you are having trouble distinguishing an access point from a wireless router, typically access 
points only have one Ethernet interface on the back of them.  Wireless routers have multiple 
Ethernet interfaces on the back of them. 
 
Below are some images that portray the different scenarios using an access point to extend a 
current wired network to work with wireless devices like StarMOBILE. 

 

Below is a scenario were a wireless router was introduced into an existing network.  This is an 
incorrect set-up. 

 

Why does my StarMOBILE device shut down when attempting to configure it for 
networking? 
You most likely have your device in Flight Recorder mode.  In this mode, the StarMOBILE 
device will shut down after 2 minutes of inactivity if it doesn’t see messages on the vehicle 
communications bus.  To configure your StarMOBILE device for networking, change the device 
to Pass-Through mode by going to the device’s main menu and selecting Enter Pass-Through 
Mode.  Note: In most cases, network setup does not involve the use of the StarMOBILE device 
menu, as configuration is usually accomplished through a browser connection to the device.  
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Read the StarMOBILE Configuration Guide for information on how to set up your StarMOBILE 
system for networking.   

Why won't my StarMOBILE device connect to my network after creating a data 
recording?  

If the device is in Flight Recorder mode, network connectivity is disabled.  From the System 
Status screen choose Enter Pass-Through Mode to re-establish network connectivity. 

Why can’t I ping my StarMOBILE device? 

• Ensure the network cable you are using is properly seated in the Ethernet jack located 
on the bottom/right of the tool. 

• Test connectivity of the network cable you are using by plugging in a different device, i.e. 
a PC and ping test again to the PC. 

• If your network does not have a DHCP server and the StarMOBILE device has a Link-
local address (169.254.x.x), the PC you are connecting from and the tool must be on the 
same network hardware, i.e. switch or hub and have the StarMOBILE Desktop Client 
installed.  Network connectivity to the Link-local range is obtained through a special 
route inserted during the StarMOBILE Desktop Installation.  If the tool is not located on 
the same network hardware as the PC or located on the other side of a router, 
connectivity will fail.  The best method of connectivity if you are unable to determine if 
the PC and tool are on the same network hardware is to disconnect the PC from the 
network and connect the PC and StarMOBILE tool via a cross-over cable.  This can be 
obtained from StarMOBILE support or from a local computer store. 

 

 
 
 

Why can’t I configure my StarMOBILE device for wireless? 

• Make sure you are within range of the access point. 
• Ensure you have typed the WPA pre-shared key properly in the wireless configuration 

section. 
• Ensure the wireless profile was saved under the wireless configuration section of the 

web-based tool setup. 
• Ensure the tool is attempting to use wireless as its default method of connectivity.  Form 

the StarMOBILE device’s Main Menu, navigate to Settings > Choose Network and select 
the wireless profile.  Once the selection has been chosen, reboot the tool. 

• Connect a laptop to the wireless network using the same settings as the StarMOBILE 
and test connectivity. 
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Vehicle Flash 

Can I flash an ECU with the StarMOBILE? 

Yes.  Flashing an ECU involves the same steps that you took when flashing an ECU from the 
StarSCAN. 

Software Updates 

What should I do if my StarSCAN & StarMOBILE Update CD is missing or defective?       

To request a replacement, call the DealerCONNECT help desk at 800-374-4040. 

How do I update the StarMOBILE software? 

Refer to the StarMOBILE™ Software Installation and Upgrade Guide for instructions on 
updating your StarMOBILE Desktop Client and device software. 

When updating from the Support CD what should I do if my USB memory device is full? 

The download wizard checks the available space on your selected USB memory device before 
writing to the device.   If the total size of files selected to download is greater than the space 
available on your USB memory device, you will be provided with options to either manually 
delete files or delete all files residing on the USB device.  Please note that deleting files is an 
irrecoverable operation, so make sure that the files you are deleting are no longer needed.  The 
Delete All option will completely remove all files on the selected USB memory device.  If you 
use this device to store other files (or have past flash updates that you may still need), do not 
use this option. 

Why can’t I write to my USB device from the StarSCAN &StarMOBILE Software Update 
CD?  

Depending on the USB Device type and previous use, it is possible that the volume name or 
label is blank.  Beginning with the 6.04 StarSCAN StarMOBILE Update CD, this information is 
required to better help identify the device when using the update wizard.  Please use the 
following procedure to correctly name your USB Device: 
 

1. Right click the Start menu select Explore > My Computer to bring up the screen below: 
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2. Right click on the USB removable drive and select Properties from the drop down menu 
to bring up the screen as shown below:   

 

3. Type USB Drive in the text box labeled Label and click OK.  
4. If the update wizard screen is currently open, close it by clicking the Exit button (lower 

right) or by clicking the X located in the top right corner of the update wizard screen. 
5. With the USB key already plugged into your computer, launch the update wizard from 

the StarSCAN/StarMOBILE Software Update CD. You should now be able to copy 
updates successfully to your USB device. 

Why does my Desktop Client freeze during installation or update? 
My does my Desktop Client software upgrade appear to finish but remain at the 
previous version? 

Check to see if anti-virus software is installed on your PC with script blocking enabled.  It should 
be noted that corporate editions of anti-virus software typically do not offer script blocking, as 
corporate firewalls prevent harmful scripts from entering the corporate network. 

Anti-virus software with script blocking enabled may cause one of the following to occur: 

• The StarMOBILE Desktop Client setup application to freeze on first-time installs of the 
StarMOBILE Desktop Client as it is installing the Bonjour discovery components. 

• The StarMOBILE Desktop Client setup application to freeze while completing the 
software installation. 

• The StarMOBILE Desktop Client setup application to appear to finish the upgrade 
successfully, but the StarMOBILE Desktop Client will remain at the previously installed 
software level. 

If you have anti-virus software with script blocking enabled, disable the script blocking feature 
and re-run the installation/update.  

Make sure you are disabling the script blocking feature. Disabling anti-virus software does not 
disable script blocking and will not correct the problem.  For McAfee VirusScan, this can be 
accomplished by: 

1. Right clicking on McAfee AntiVirus icon in the system tray 
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2. Click Advanced 
3. Click Exploits 
4. Uncheck "Enable ScriptStopper (recommended)" 

For Norton AntiVirus 2005 software, this can be accomplished by: 

1. Right clicking on NAV icon in the system tray 
2. Choose Norton Settings 
3. Click Script Blocking 
4. Clear Enable Script Blocking and click OK 

You can re-enable script blocking once you have successfully installed or upgraded the 
StarMOBILE Desktop Client software.  If you re-enable script blocking, you will need to disable it 
the next time you update the StarMOBILE Desktop Client software. 

Where are the flash files on the latest StarSCAN StarMOBILE Update CD? 

Flash files have not been included on the StarSCAN StarMOBILE Update CD since version 
6.05. Flash files will only be available online via DealerCONNECT or Tech Authority. Providing 
flash files via DealerCONNECT and Tech Authority ensures that only the most current flash files 
are used to update vehicle ECUs. 
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